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Overview 

Stellar Repair for MS SQL software is an easy to use application designed to repair corrupt or damaged 
Microsoft SQL Server database (MDF) files in a safe and non-destructive manner. It uses powerful 
algorithms to perform thorough scan of MDF file so as to recover as much data as possible. The software 
never deletes or modifies original data and even heavily damaged files can be optimally repaired and 
restored. 

Microsoft SQL server system is a full-fledged relational database management system (RDBMS) that 
offers an exclusive variety of a number of administrative tools for database development, maintenance, 
and administration. Microsoft SQL Server database files (MDF) can get damaged or corrupted due to a 
number of reasons such as virus attack, unexpected system shutdown, media read error, and so on. 

Key Features 

 New and enhanced GUI. 

 Saves the Scan Information. 

 Option to save repaired database to SQL Server Authentication. 

 Support for MS SQL Server 2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 
2012 R2, 2012, MS SQL Server 2008 R2, 2008, 2008 (64 bit), 2008 Express, MS SQL Server 
2005, 2005 (64 bit), 2005 Express, MS SQL Server 2000, 2000 (64 bit), 7.0 and mixed formats. 

 Searches MDF files in the computer. 

 Displays preview of recoverable database objects. 

 Allows finding of object name in tree view. 

 Supports Sequence Objects in MS SQL Server. 

 Supports MS SQL Server ROW Compressed data. 

 Supports MS SQL Server PAGE Compressed data. 

 Supports Standard Compression Scheme for Unicode (SCSU) in SQL Server. 

 Recovers Column Row GUID COL Property. 

 Recovers Sp_addextended Property. 

 Saves non-recovered queries, views, stored procedures, etc. in a text file. 

 Support for automatic recreation of a new database having all the recovered database items. 

 Support for large SQL Server MDF files for all versions. 
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 Support for XML data types. 

 Support for XML indexes. 

 Support for SQL Server filestream data types. 

 Support for SQL Server sparse columns. 

 Support for SQL Server columns set property. 

 Support for separate log report after scanning database. 

 Support for Sorted tables in tree view and generates sorted log report. 

 Support for fast scanning algorithms. 

 Support for total row count detail in each table for all versions. 

 Recovery of Tables, Triggers, and Views. 

 Recovery of Collations. 

 Recovery of Stored Procedure, Synonyms, and Functions. 

 Recovers of Defaults and Default constraints. 

 Recovery of Primary Keys, Foreign Keys, Unique Keys, and Identity. 

 Recovery of Indexes ( Clustered, Non - Clustered indexes). 

 Recovery of Check constraints, User Defined Data Types, and Null / Not null. 

 Recovery of Predefined defaults, default values, and Rules. 

 Compatible with Windows Server 2012 / 2008 / 2003 and Windows 10 / 8 /  7 / Vista / XP. 

 Option to recover deleted records. 

 Option to save repaired database to Live database. 

 Option to save repaired database as CSV, HTML and XLS. 
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Installation Procedure 

Before beginning the installation procedure, make sure that the computer meets the minimum system 
requirements. 

Minimum System Requirements: 

Operating system:  Windows Server 2012 / 2008 / 2003  and Windows 10 / 8.1 / 8  /  7 / Vista / XP 

Hard Disk: At least 250 MB of free disk space 

RAM: 2 GB minimum (4 GB recommended) 

MS SQL Server: MS SQL Server 2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 
2012, MS SQL Server 2008 R2, 2008, 2008 (64 bit), 2008 Express, MS SQL Server 2005, 2005 (64 bit), 
2005 Express, MS SQL Server 2000, 2000 (64 bit), 7.0 and mixed formats. 

To install the software, follow the steps: 

1. Double-click Stellar Repair for MS SQL.exe. Setup dialog box is displayed. 

2. Click Next to continue. License Agreement dialog box is displayed.  

3. Select I accept the Agreement option. Click Next. 

4. Specify the location where the installation files are to be stored. Click Next. 

5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click 
Browse to select a different location. Click Next. 

6. In the Select Additional Tasks dialog box, select check boxes as per your choice. Click Next. 

7. Review your selections. Click Back if you want to make any change. Click Install to start 
installation. The Installing window shows the installation process. 

8. After completion of the process, Completing the Stellar Repair for MS SQL Setup Wizard 
window opens. Click Finish. 

Note: Clear Launch Stellar Repair for MS SQL check box to prevent the software from launching 
automatically. 
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Launching the Software 

To launch Stellar Repair for MS SQL in Windows 10: 

 Click Start icon -> All apps -> Stellar Repair for MS SQL -> Stellar Repair for MS SQL Or, 

 Double click Stellar Repair for MS SQL icon on the desktop. Or, 

 Click Stellar Repair for MS SQL tile on the home screen. 

 

To launch Stellar Repair for MS SQL in Windows 8.1 / 8: 

 Click Stellar Repair for MS SQL tile on the home screen. Or, 

 Double click Stellar Repair for MS SQL icon on the desktop. 

 

To start the application, do one of the following in Windows 7 / Vista / XP: 

 Click Start -> All Programs -> Stellar Repair for MS SQL -> Stellar Repair for MS SQL. Or, 

 Double click the Stellar Repair for MS SQL icon on the desktop. Or, 

 Click Stellar Repair for MS SQL icon in Quick launch. 
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User Interface 

Stellar Repair for MS SQL software has a very easy to use Graphical User Interface. The user interface 
contains features required for complete recovery of corrupt MS SQL Server (MDF) files. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains ribbons and buttons that lets you access various features of the software with 
ease. 

When you start Stellar Repair for MS SQL, the Select database dialog box opens as shown below: 
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To select a database, click on Browse button. Select the MDF file that needs to be repaired and then 
click Repair to start the repairing process. 

Stellar Repair for MS SQL also allows you to search for MDF file that needs to be repaired, in case you 
don't know it's location. In Search section, select the drive in which you want to search for the MDF file 
and then Click OK to start searching for files. 

Note: Select database dialog box can also be opened by selecting Select database in the File ribbon. 
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Ribbons 

File Ribbon 

Select Database 

Use this option to select the 
corrupt SQL database for 
repairing. 

Save 

Use this option to save the 
repaired SQL database. 

Stop 

Use this option to stop the 
repairing process. 

View 

Use this option to view or hide 
the Status Bar and Log 
Window. 

Deleted Records 

Select this check box to show 

or hide deleted records in the 

tree view (if found) during the 

repairing process. 

 

Search String 

Use this option to search a 

string in the database file. 

 
 
 
 
 
 
 

 

File Ribbon 

Tools Ribbon 
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Save Log 

Use this option to save the log report. 

Clear Log 

Use this option to clear the log report. 

Update 

Use this option to update the software. 

 
 
 

 

Tools Ribbon 

 

Help Ribbon 

Help Topics 

Software is accompanied by a descriptive help 
document. Use this option to view the help 
manual for the software. 

Support 

In case you don't find any related content in the 
help document or on the knowledgebase page 
that resolves your query, use this option view the 
support page of stellarinfo.com and contact the 
Stellar customer support. 

Knowledge Base 

Frequently asked questions and other common 
queries are available as knowledgebase for your 
reference and to help you use the software to get 
the best outcome. Use this option to visit 
Knowledge Base articles of stellarinfo.com 

About 

Use this option to read more information about 
the software. 

 

 
 
 
 
 
 

 

Help Ribbon 

https://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
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Buy Ribbon  

Buy now 

Use this option to buy Stellar Repair for MS 
SQL. 

Activation 

You can repair corrupt or damaged Microsoft 
SQL Server database (MDF) files to recover as 
much data as possible using the trial version of 
the software. To save the recovered data, you 
need to purchase and activate it. Use this option 
to activate the software after the successful 
purchase. 

 
 
 

 

Buy Ribbon 

 

 

  

https://www.stellarinfo.com/database-recovery/sql-recovery/buy-now.php
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Buttons 

 
 

 
 
Click this button to open Select SQL database dialog box. 

 
 

 
 
Click this button to save the repaired SQL database. 

 
 

 
 
Click this button to stop the repairing process. 

 
 

 
 
Click this button to save the log report, which contains the details of the repairing 

process. 

 
 

 
 
 
Click this button to clear the log report. 

 
 

 
 
Click this button to activate the software after purchasing. 

 
 

 
 
Click this button to update your software. Use this option to check for both, major 
and minor versions of the software. 

 
 

 
 
Click this button to purchase the software. 

 
 

 
 
Click this button to visit the Knowledge Base articles of stellarinfo.com 

http://www.stellarinfo.com/
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Click this button to open the help manual for Stellar Repair for MS SQL. 

 

 
 
Click this button to read more information about the software. 
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Ordering the Software 

Click https://www.stellarinfo.com/sql-recovery.php to know more about Stellar Repair for MS SQL. 

To purchase the software online, please visit https://www.stellarinfo.com/database-recovery/sql-
recovery/buy-now.php 

Alternatively, click on Buy now icon in Buy online Ribbon on Menu Bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a key will be sent to you through e-mail, which would be required to activate 
the software. 

Activating the Software 

The demo version is for evaluation purpose only. You need to activate the software to use its full 

functionality. Use the Activation Key received via email after purchasing the software to activate it.  

 

To activate the software: 

 

1. Run Stellar Repair for MS SQL. 

2. Click the Activation button. Activation window is displayed as shown below: 

 

 

 

3. If you don't have the activation key, click Get it now button in the window to purchase the 

software. 

4. Once the order is confirmed, an Activation Key is sent to the email that you have provided while 

purchasing the software. 

5. Paste or type the Activation Key (received through email after purchasing the product) and click 

Activate button (Please ensure an active Internet connection). 

https://www.stellarinfo.com/sql-recovery.php
https://www.stellarinfo.com/database-recovery/sql-recovery/buy-now.php
https://www.stellarinfo.com/database-recovery/sql-recovery/buy-now.php
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6. Stellar Repair for MS SQL automatically communicates with the license server to verify the 

entered key. If the entered key is valid, activation is completed successfully. 

7. 'Activation Completed Successfully' message is displayed. Click OK. 
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Updating the Software 

There are periodical software updates for Stellar Repair for MS SQL. Using the update option, you can 
check for both latest minor and major version available online. You can easily download the minor and 
major version through the update wizard. While updating the software, it’s recommended to close all the 
running programs. 

To start Stellar Repair for MS SQL Update Wizard: 

1. Run Stellar Repair for MS SQL software. 

2. Select Update from Tools Menu.  

3. Update window pops up. 

4. The wizard will start searching for the latest updates and if it finds any new version, a window will 
pop up indicating the availability an update. 

5. Click Next and the software will start downloading update files from the server. When the process 
is complete, the software will updated to the latest version. 

Live Update may not happen due to following reasons: 

 Internet connection failure 

 Unable to download configuration files 

 Unable to locate updated files or version 

 Unable to locate executable file 
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Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/database-recovery/sql-
recovery/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/database-recovery/sql-recovery/buy-now.php
https://www.stellarinfo.com/database-recovery/sql-recovery/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com
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Select MS SQL Database (MDF) File 

To select MDF file: 
 
Stellar Repair for MS SQL allows you to select MS SQL database (MDF) files from your computer for the 
repairing process. 
 

1. Open Select Database 
dialog box by choosing 
Select Database icon 
from File Menu. 

2. In Select Database 
dialog box, click Browse. 

3. Open dialog box will 
appear. Browse and 
select the desired file and 
then click Open. 

4. Select 'Include Deleted 
Records' check box to 
recover deleted records 
(if found) during the 
repairing process. 

 

 

To find MDF File: 

Stellar Repair for MS SQL also allows you to search for MS SQL database (MDF) files in your computer. 
Using Search option, you can search for MS SQL Database files in your computer's drives, folders and 
sub folders. However, you can only select one drive at a time to search for MS SQL Database files. 

To find MDF files in drives: 

1. Open Select Database 
dialog box by choosing 
Select Database icon 
from File Ribbon 

2. From Search section, 
 select the drive you 
want to search for MDF 
files. Click OK. 

3. After the search is 
finished, a list of MS 
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SQL Database files 
found in the selected 
drive is shown. 

4. Select file you wish to 
repair from this list and 
click Repair button to 
start the repairing 
process. 

To find MS SQL Database 
files in folders and 
subfolders: 

1. Open Select Database 
dialog box by choosing 
Select Database icon 
from File Ribbon 

2. From Search section, 
 select the folder or 
subfolder you want to 
search for MDF files. 
Click OK. 

3. After the search is 
finished, a list of MS 
SQL Database files 
found in the selected 
drive is shown. 

4. Select file you wish to 
repair from this list and 
click Repair button to 
start the repairing 
process. 

Note: Click Clear List 
button to clear the search 
result. 

 

Include Deleted Records 

Stellar Repair for MS SQL provides you an option to include deleted records in MS SQL database 
(MDF) repaired file. 

To include deleted records follow the steps given below: 

1. Select the file by clicking on the Select Database icon from the File Ribbon or from the list of MS 
SQL Database files found, select the desired file to repair. 
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2. Select 'Include Deleted Records' check box to recover deleted records (if found) during the 
repairing process. 

 

3. Click Repair to start the repairing process. Repairing of the selected files is performed by the tool. 
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Repair MDF Files 

Stellar Repair for MS SQL repairs MS SQL Database (MDF) files and allows you to save to your 
preferred location. You can also preview the repaired database before saving it. 

To repair MS SQL Database files: 

1. Select the file by clicking on the Select Database icon from the File ribbon or from the list of MS 
SQL Database files found, select the desired file to repair. 

 

2. Click Repair to start the repairing process. Repairing of the selected files is performed by the tool. 

3. After the completion of repairing process, a message appears indicating the successful 
completion of the process. 

 

 
Note: 

o If the selected database file is heavily corrupted and application is unable to detect the database 
file version, then you can select the database version manually from the dialog box as shown 
below: 
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o If in case you select invalid version of the database file, then a message prompts on the screen 
indicating the inappropriate version of file.  

 

o To proceed to the repairing process, you need to select the appropriate version.  

Save Scan Information 

Stellar Repair for MS SQL saves a scan information of the MS SQL Database (MDF) File at the time of 
repairing. This saved scan information can be used later to repair corrupt database in case you wish to 
repair the database file again. 
 
Using a scan information saves time, since scanning of each database file does not take place. All files 
and folders shown after scan process can be viewed as we load the saved scan information created for 
that particular scan. You can resume recovery by selecting the saved scan information without scanning 
the database again. 
 
To Repair Database using scan information 
 

1. You will be prompted to use the saved scan information for selected database. 
2. Click Yes if you want to repair using the existing saved scan information. 
3. Click No if you want to repair using selected database itself. 

 
 
 
 
  



22 

Preview and Save MDF Files 

After you complete the repairing process successfully, Stellar Repair for MS SQL shows preview of 
corrupted database files. The left pane displays list of items (Tables, Views, Synonyms, Defaults, Data 
Types and more) in a tree like structure, upper right pane displays the contents of the item selected in the 
tree view and bottom pane shows message log. A sample screen is displayed below: 

 

By default, all the checkboxes of the tree view are selected. You can click on the item in the tree view to 
preview its content. 

Note: The software performs a counting of records present in the database after repairing process is 
completed. The time taken in counting depends on the number of records present in the database. You 
can skip the counting of records to speed up repair process without affecting the repair results. 

To save the repaired file to MS SQL database: 

 After the repairing process gets completed, click Save option from File ribbon. 

 Specify whether you want to save the repaired database in MDF, CSV, HTML or XLS format by 
selecting the appropriate radio button. 

Saving repaired database as MDF 

Saving repaired database as CSV, HTML or XLS 

 

If you want to save your repaired database as an MDF, you can either save your database as a New 
database or you can insert the data to an existing Live database. 
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 To save the repaired database as a completely New database, follow the steps mentioned 
below: 

o Select New Database radio button. 

o Enter Server / Instance Name. 

o Choose the Authentication method from the drop down list for logging in to the server. If 
the authentication method selected is Windows Authentication, you need not enter any 
user name and password. 

 

o Enter the server user name and password, if the selected authentication method is SQL 
Server Authentication. 
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o Select a destination for saving the repaired MDF file. 

o Click Save button to save the repaired MS SQL Database file. A message is displayed 
after the process is completed successfully. 

 

 To save the repaired database in an existing Live database, follow the steps mentioned below: 

o Select Live Database radio button. 

o Enter Server / Instance Name. 

o Choose the Authentication method from the drop down list for logging in to the server. If 
the authentication method selected is Windows Authentication, you need not enter any 
user name and password. 
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o Enter the server user name and password, if the selected authentication method is SQL 
Server Authentication. 

 

o From the Existing Database drop down button select the database into which you want 
to save the repaired file. 

o Click Save button to save the repaired MS SQL Database file. A message is displayed 
after the process is completed successfully. 
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To save the repaired file to CSV , HTML or XLS format: 

 After the repairing process gets completed, go to File ribbon and select Save option. 

 Save dialog box will open. Select the required format. 

 

 Click Browse to go to the folder where you want to save the repaired file and click Save button. 

 The file will be saved in the desired format. 

Note: Perform repair process on the copy of database and make sure MS SQL Server is running during 
repair process. 
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Find Specific Item In Tree 

Stellar Repair for MS SQL gives option to find particular item(s) in tree view. After completion of 
repairing process, a search bar along with the preview window appears as shown below: 

 

To find a particular item, enter its name in Find Tree Item text box and click Find button. If that item is 

present in the database, it is highlighted in tree. Use back  and forward  button to traverse in 
the tree. 

To narrow down the search result, you can select Match case or Match whole word check box. 
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Save Log Report 

With Stellar Repair for MS SQL, you can save the Log Report to analyze the repairing process at a later 
stage. You can view log of the process at the bottom of the user interface. If this pane is not visible, you 
can enable it by selecting the Log Window checkbox in View section of File Ribbon. 

To save log report: 

 From Tools Ribbon, select Save Log. 

 In Save As dialog box, select the location where you want to save the log report. Click Save. 

To clear log report: 

 From Tools Ribbon, select Clear Log. 
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FAQs 

1. What does the demo version of the software do? 

Demo version of the software only shows the preview of MDF files. To repair corrupt MDF file, you 
need to purchase and register the software. 

2. Why is it necessary to perform repair process on the copy of database? 

Stellar Repair for MS SQL will not be able to run if the database is attached to MS SQL Server. 

3. Can we repair table(s) in a MDF file selectively? 

Yes, you can recover single or multiple tables. Simply select desired table(s) in tree view and start 
repair process. 

4. How can Stellar Repair for MS SQL help me search for the location of MDF file in the 
computer? 

You can search for MDF file in the computer using Search option of the software. For more details, 
please refer Select MS SQL database ( MDF ) File topic of the help manual. 

5. I want to locate an item in the database ( MDF ) file. Is there any way I can do this using the 
software? 

Yes, after repairing the MDF file, the software gives you option to find items in tree view. Use Find 
option to locate desired item in a table. 

6. How can we view process log? 

You can view log of the process at the bottom of the user interface. If this pane is not visible, you 
can enable it by selecting the Log Window checkbox in View section of File Menu. 

7. Can we save process log? 

Yes, Stellar Repair for MS SQL gives you option to save log report of the process. 

To save log report: 

 From Tools Menu, select Save Log. 

 In Save As dialog box, select the location where you want to save the log report. Click Save. 
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Legal Notices 

Copyright 

Stellar Repair for MS SQL software, accompanied user manual and documentation are copyright of 
Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 
user manual cannot be reproduced in any form without the prior written permission of Stellar Information 
Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

Copyright© Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 
THEREOF. 

Trademarks 

Stellar Repair for MS SQL® is a registered trademark of Stellar Information Technology Private Limited. 

Windows XP®, Windows 2003®, Windows Vista®, Windows 7®, Windows 8® and Windows 10® are 
registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 
companies. 

License Agreement 

Stellar Repair for MS SQL 

Copyright © Stellar Information Technology Private Limited INDIA 

www.stellarinfo.com 

All rights reserved. 
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All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Repair for MS SQL. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by Stellar Information Technology Private 
Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 
use any copy of Stellar Repair for MS SQL with which this License is included, you may return the 
complete package unused without requesting an activation key within 30 days after purchase for a full 
refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
Stellar Repair for MS SQL. For purposes of this License, if you have a valid single-user license, you have 
the right to use a single Licensed Copy of Stellar Repair for MS SQL. If you or your organization has a 
valid multi-user license, then you or your organization has the right to use up to a number of Licensed 
Copies of Stellar Repair for MS SQL equal to the number of copies indicated in the documents issued by 
Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Repair for MS SQL may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. This 
is not a concurrent use license. 

All rights of any kind in Stellar Repair for MS SQL, which are not expressly granted in this license, are 
entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You may not 
rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based 
on Stellar Repair for MS SQL nor permit anyone else to do so. You may not make access to Stellar 
Repair for MS SQL available to others in connection with a service bureau, application service provider or 
similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Repair for MS SQL and all accompanying software, files, data and materials are distributed and 
provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge that 
good data processing procedure dictates that any program including Stellar Repair for MS SQL must be 
thoroughly tested with non-critical data before there is any reliance on it and you hereby assume the 
entire risk of all use of the copies of Stellar Repair for MS SQL covered by this License. This disclaimer of 
warranty constitutes an essential part of this License. In addition, in no event does Stellar authorize you 
or anyone else to use Stellar Repair for MS SQL in applications or systems where its failure to perform 
can reasonably be expected to result in a significant physical injury or in loss of life. Any such use is 
entirely at your own risk and you agree to hold Stellar harmless from any and all claims or losses relating 
to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 
of business profits, business interruption, loss of business information, or any other pecuniary loss) 
arising out of the use of or inability to use the software product or the provision of or failure to provide 
support services, even if Stellar Information Technology Private Limited has been advised of the 
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possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 
under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 
of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 
violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 
future violation of the same provision or any other provision of this License. 

Copyright© Stellar Information Technology Private Limited. All rights reserved. 
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About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 
Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 
almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 
format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 
tools. More Info >> 

Database Repair 

A wide range of database repair software to help you repair corrupted Microsoft SQL Server database, 
Microsoft Access database, MySQL database, Oracle database, SharePoint Database, SQL Anywhere 
Server and Interbase database. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 
Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 
More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 
complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 
utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

For more information about us, please visit www.stellarinfo.com 
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